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13-QUOTATURE

Aprire il file UNIONE LUCIDI e salvarlo col nom®UOTATURE
In genere si quotano oggetti con vista 2D, per oggetti 3D va ricordato che le quotature non seguono
i cambi di vista
Le quotature sono registrate per difettcilass: Dimension (Categoria Quote).
Consiglio in ogni caso:
- Di creare il lucido di quotatura relativo al disegno da dimensionare(ad esempidPperoil
terra, si creera’ il lucid®uote Piano terra ecc.)
- Rendere invisibili gli altri lucidi
- Attivare Organize>Layer Option>Show/Snap Other (mostra/aggancio altro lucido)
A scanso d'equivoci definiamo gli elementi di una quotatura:

34,12cm
—- .
Linea di quota

- / 320cm -
/ ¢ _ =1 inea testimone
Testo di guota

Marcatore
e - Page>Units
- Set Unitsfor:General Display
Set Units for: [GeneralDi5|:|lfn.r i] . . .
(Visualizzazione Generale)
rUnit of Measurement A A A
Unit Name: [ Cenfimeters O - Unit Name (Tipo): Centimeters
[ Show Unit Mark - Spuntareshow Unit Mark (Visualizza
Rounding Unita' di misura)
() Fractional - SpuntareDecimal. In Round To Near est
(Arrotonda a), dal Menu a tendina indicare
I precisione decimale

Round to nearest:

{2 Fractional / Decimal Mix

- In Angles (Angoli) scegliere fraDegrees
(Gradi),Radians (Radianti),Gradians(Gradi
centesimali) indicando la precisione nel menu

-Angles Decimal Formatting - a tendindrecision
# Degrees () Radians () Gradians| | [ Leading Zero - InDecimal For matting (Formato decimali)
acision: [ Trailing Z . .
Precision g feres spuntareteading Zero (Zero prima della

[ cancel | virgola)Trailing Zero (Zeri dopo la virgola)
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- Impostiamo lo stile quote:

Autore Paolo Sidoli MANUALE VECTORWORKS

e - File>Preferences >Document Preferences
j Display Y Dimensions % Render %/ QD30 A . L . . .
- Dalla finestra di dialogo cliccai2imensions
Di jion Standard o +-Di ion Slash Thickness: . . . . .
L oo - In Dimensions Standard (Dimensioni Standard),
ASME 3 Mils . . . -
bsi | o nel il menu a tendina sono elencati tutti gli
DIN P . . . .
150 o standard internazionali supportatiWa/;
E':"m:gua:;de:yzm - In Dimenisons Slash Thickness (Dimensioni
Click this item to change the default dimension standard for dimensions. Spessore Marcatore) deflnlamo |O Spessore
indicando l'unita’ di riferimento
=

Se vogliamo impostare uno standard personale:

- CliccareCustom ( Quote Personali)

Document Preferences
— e : - In Custom Dimensions (Definizione Quote
flwlay = RE::&:m IJir\rlrensil:m(;mn . ( Q
Personali):
DI jon Standard New...
- OK
] Custom... J
-
B
=
imensions 4 nder Y
y 0 REII:LUI’II Dinn_-n:'iLm(:I:rm I
Assign Name =———— [ New... :‘l = NF,\N
Name this standar: %l - In Assign Name, assegniamo un nome al nostro standard,
[Quote personal N = ad esQuote per sonali
(Cancer | [_ok_J || Cimport..]
- OK
ok |

- Click Custom

- Selezionar&uote per sonali
- Click Edit

- OK

17-QUOTATURE

J Display " Dimensions Render QDD M
=—— Custom Dimensions =——=
Di ion Standard
3
Rename...
u
B
Click this button to define or modify cuztom "
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- Dalla finestra di dialog€ustom Dimension, possiamo impostare i parametri della quotatura a
nostro piacimento:

Custom Dimension

Custom Dimension: Quote personali

159 A| [159 B
T .

x
fose “H T o

7.62 3,17 H

159 |

Linear Markers: [~ | [ Select.. | 635 |
Other Markers: [+ ] [ Select.. |

i witness Lines A Align Vertical Text Left

[ Fixed Witness Line Length Tolerance Size: ‘3’0
[ Dimensions Always Inside Text Rotation: | Aligned |

[151A Format Numbers Layout: | Single |

NOTE: Distances arein - mm [ Cancel ] [ 0K “

-A: Lunghezza dellaineadi quota all'esterno deM ar catore

-B: Distanzar esto di quota dalMar cator e (positiva in alto, zero a livello marcatore, negativa in
baso)

-C: Distanza fra_inea di quota concatenate

-D: Sporgenza. inea testimone dallaLinea di quota

-E: Lunghezzd.inea di quota quotatura esterna

-F: Distanzal inea testimone - Oggetto

-G: Lunghezza linea verticale

-H, I, L: Definiscono il tratteggio linee dello Strumenar catore Centrale

- WitnessLine(Linea testimone) :Spuntandola si attiva il disegno della Linea testimone

- Fixed WitnessLineLegth (Lunghezza linea Testimone Fissa): Attiva la casella per definire la
lunghezza della linea testimone

- Dimensions Always Inside Spuntandola le dimensioni compaiono all'interno della Linea di
Quota.

- Linear Markers, Other Markers Permette di selezionare i marcatori

- Al termine dell'operazion®@K
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Come possiamo modificareTlesto di Quota ?. Semplice, dal Mentiext (Testo) definiscd-ont
(Caratteri),Size (Dimensioni) Style (Stile)

Per attivare 1& avolozza Quote:

- Palettes>SDimensioning compare la Tavolozza quote

- Quotelineari (orizzontali e verticali)
- Quotetrasversali

- Quoteradiali

- Quoteangolari

- Marcatore Centrale

- Righélo

- Goniometro

Prendendo dal detto "val piu' la pratica che la grammatica” cominciamo :

1- Da Quotelineari .

=l H
2- Cliccare la modalitaQuotatura continua ‘I_lk__l_l_l_l_‘_” ST "'—”
1

RN

1" CLICK
-+ £ - Spostare il mouse verso l'angolo in alto a sinistra delle
pareti esterne e quando compare l'indicaztong e fare
un click
4- Senza premere il mouse spostarsi in verticale verso I' angolo
= ' in basso a destra e quando compare l'indicaPoiné e
]
ks : fareun click
]
5- Senza premere il mouse spostarsi verso sinistra con l'ausilio
dell'indicatorédorizzontal e fare click nella posizione
R desiderata.
l———=—6- Compare la quotatura:

Fa. i1
-, =Lt oy
x_ﬁ' CLICIc.: 2" CLICH

Partendo da questa quotatura, prendiamo in esame i vari metodi per modificarla:
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- Modifiche quotatura col mouse:

¥
=

—=

— Modifica lunghezza Linea testimone

-Click sulla Linea di quota

cdder|

e\, "= -Spostarsi nella direzione parallela desiderata

-Click per terminare

I

M odifica lunghezza posizione Testo quota

-Click al centro del Testo di quota

-Col mouse premuto spostare il Testo quota della posizione
voluta

-Click per terminare

SO0cmr

"I_;] Align H

-Modifiche quotatura col Palette Object Info (Tavolozza Infor mazioni):
-Spuntare in bassghape (Oggetto)
-Selezionare la quotatura da modificare

Dirnension

Cles=: [ERRCEEE -Palettes>Object Info o (Melal)

Layer: [Piano terra -Class: permettono di modificare la Categoria
Drirn Std: [ pippo

-Layer: permettono di modificare il Lucido d'appartenenza

C -Dim Std: si puo' modificare lo standard prescelto.Cliccare sul
menu a tendina e provare ad inserire un altro Standard.

——— -Witness (Linee testimone):Dal menu a tendina si possono
[ Box Text utilizzare:Both (Entrambe)Ending (Finale),
2 Srov Dim Vse Starting (Iniziale), None (Nessuna)
— _ ML -Arrows Inside (Linea di quota interna): togliendo la spunta
[\ Shape i Dsta _J | otteniamo la Linea di quota esterna

“Withess: [ Eath

Diirn OFF: [-57 1 549%cm
B Arrows Inside

[ Text...

S00cr

o 5 5
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-Text: Dal menu a comparsa possiamo:

Dimension Text

-Offset Above Line: Definire la distanza

dalla Linea di quota Offset Above Line: | Horizontal |]
. ] ] . Aligned
-Rotation: Ruotare il testo di quota in

. . . . +
Orizzontale,Allineato ,Orizzontale/Verticale O Auto Position [ Cancel |

-Auto Position :posizionare automaticamente il
Testo di quota
-Box Text: Far appare in un riquadro il Testo di quota con la spunta
-Show Dim Value: Mostrare o meno le quote reali ihesto di quota
-Leader: Inserire valori e/o testo capoletteraligsto di quota E' utile se, disattivandghow Dim
Value vogliamo inserire quote che non sono quelle misurate.

-DaQuotelineari (1).

-Cliccare la modaliteQuotatur a concatenata ||4—'1||+r1+r| WITT TI ml
1A .

EMa -

107,6
| 3

1 | 2

[ —

-Spostare il mouse verso l'angolo in alto a sinistra delle pareti egigerguando compare
I'indicaziondoint e fareun click

-Segquire il perimetro della parete sino all'inizio della porta scorrevole arfaiéeck. (2)

-Spostarsi in orizzontale nel punto dove mostrare le quotature @nfahek. (3)

-Appare l'indicazione di posizione

|
1.414 5
—

e — — — P

= |iHing ooy

NI

-Senza premere il mousieliscenderen verticale sulla parete e spostarsi, con l'ausilio
dell'indicazione sino, alla fine della porta d'ingresso. Quando cofpiantefareun click
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-Ripetere I'operazione per dimensionare le finestre e tratti di parete
-Doppio click

-Tornare col mouse all'inizio del muro. CompRaent. Fareun click

-Spostarsi in orizzontale sino alla fine del muro e quando compare l'indic&niodareun click
-Risalire sopra la linea di quota concatenata diarelick, compare la quotatura della parete

-3 click per concludere lguotatur a concatenata.

-Per terminarére click

Selezioniamo Strument@onstrained Base-Line Dimension HIW&TTT H—Hl
(Quotatura su Linee Parallele) AT Tarme +

-Portiamoci nell'angolo inferiore destra

della casdl) 1click
\j \—‘ -Spostiamoci a sinistra verso il centro
finestre(2) 1click
5 -Risaliamo in verticale per definire la
I Linea Testimon€3) 1 click
*3 157,62 -Scendiamo sulla linea del muro esteffip
e spostiamoci a sinistra verso il centro

S9E finestre (5) 1 click

-Ripetere I'operazione e tre click per terminare

Andiamo nel luciddCasa (contenente la vista d'insieme)
-View>Standard View>front

-Selezionare || IS T G| 2

I
Eho oL g

300 _ i

270 L3+—

-Posizionarsi col mouse alla base della faccia esterna del(fruro

- 1 click spostarsi sulla sinistfa)

- 1 click e compare l'altezza .Il cursore si trasforma in mirino

- senza premere il mouse ritornare verso la faccia esterna de{Ihuro
- spostarsi in verticale sino al punto dove fare la seconda nisura

- 1 click e compare l'altezza

- ripetere l'operazione per altre misure

- doppio click per uscire %
H—-hﬂ‘l
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| | 2

—n

7.

-

Ik lenn

+

--View>Standard View>Top/Plan o (Mela5)
-Selezionare le mura esterne laterali destra

-Cliccare sullo strumento Modalita’ Oggetto Selezionato

-Spostarsi verso destra

-Click ed appare la quotatura

Autore Paolo Sidoli MANUALE VECTORWORKS

Eu_ Selected Object M ode (Modalita’ Oggetto Selezionato)

-

|

-

Non vi va' la posizione del testo di quota? Spostiamola!

Obj Info

Dirnension

Clazs: Dirnenzion
Layer: Piano terra
Dirn 5td : | pippo
Witness:
Dirn Off:
|z Arrows Inside
Text...

5]
=}
Ak [l |l

Frec:
D Bz Tesxt
Eshow Dimn Value
Leader :

1

[s=
“1'_ Shape Data

1

Dimension Text

Offset Above Line:

Rotation:

[ Auto Position

795
[ Cancel ][ 0K ]

Ecco il risultato

17-QUOTATURE

Da Object Info click Text

In Dimension Text la distanza dalla
linea quota &,95.

Sostituiamola cord0

OK

{ulu]
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- Selezioniamo ancora il muro

- Selezioniamo lo strumento

- Posizioniamoci nel muro

- Spostiamo il mouse verso l'alto

- Compare la dimensione orizzontale o spessore

25

T_h

La modalita’ Oggetto selezionato &€ molta comoda per dimensionare oggetti non aventi profili
continui.

Per le quotaure trasversali valgono gli stessi concetti di quelle lineari

-Selezioniamo d®uote trasversali, Quotatura Continua

=

)
_____________________________________ .DE
=l - Posizionarsi nell'angolo
inferiore sinistra(1) ed un
click
,.1;}‘-'::*““ - Senza premere il mouse,

spostarsi nell'angolo
superiore destra(2)
- Doppio click

Salvare (col nom@UOTATURE se non fatto in precedenza)

17-QUOTATURE Autore Paolo Sidoli MANUALE VECTORWORKS 9



17-QUOTATURE Autore Paolo Sidoli MANUALE VECTORWORKS

Continuiamo con i comandi di quotatura.
Disegniamo, fuori dell'area di disegno, un cerchio

Quoteradiali: Questo quadro sinottico spero valga piu' di cento parole.

1) Diametro interno  2) Diametro esterno  3) Raggio interno 4) Raggio esterno

Per i comandi seguenti, bisogna trascinare il mouse all'esterno della circonferenza della distanza
desiderata per inserire il Testo di quota

@ @ . 5) Testo quota laterale destra
@ 190 R o5
Q 6

6) Testo quota laterale sinistra

'IQO—/‘I R85

17-QUOTATURE Autore Paolo Sidoli MANUALE VECTORWORKS 10



17-QUOTATURE Autore Paolo Sidoli MANUALE VECTORWORKS

- Strumento Quote angolari: Disegniamo fuori dell'area di disegno due poligoni irregolari

o EI 1)Quota angolar e fra due oggetti:

Cp O

i 7

-Andare col mouse al puniio -Cliccare e spostarsi con la freccia fra i due
-Cliccare, rilasciare ed andare al pugto oggetti
25°

-Cliccare e compare la quotatura angolare interna

-Andare col mouse al punio -Cliccare e spostarsi con la freccia all'esterno dei
-Cliccare, rilasciare ed andare al pugto due oggetti

-Cliccare e compare la quotatura angolare esterna

335-
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mﬁl ) ) Quota angolar e con linea di riferimento

-Tracciare col mouse la linea di riferimento  -Cliccare e spostarsi con la freccia a forma di
mano verso l'oggetto

0 o)

-Cliccare e spostarsi con la freccia a destra i {idiccare e spostarsi con la freccia a sinistra per
angoli interni angoli eserni

Uscire senza salvare
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